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Navigating TE 

To use the many features of TOPSpro Enterprise (TE), 
you will need to know how to find them by navigating 
through the menus. TE uses the same type of menu 
system that you see in most Windows-based 
applications. 

Install and Open TE Online 

To access TOPSpro Enterprise Online (TE) for the first time, launch the web browser and enter the 
URL for the CASAS Online System your program uses.* 

Server Use any modern web browser 
*Global https://etestsonline.org/html5/#/ 

 

Step Screen Description 
1.  

 
 
 

 
 

• Access TE in one of three ways, from the –  

1. Web browser 

• Click Install TE Client if first 
access on local machine. 

2. Taskbar icon 

3. Desktop icon 

2.  

 

• Click the Server field down-arrow and from 
the drop-down menu, 

o Select the Server for your online 
account.* 

o Enter your Agency ID. 
o Enter your User name. 
o Enter your Password. 

• Click Connect. 
 

1 

2 

3 

https://www.casas.org/training-and-support
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Explore Menus and Submenus 

TE opens with an empty screen and a menu bar 
along the top. Not all agencies using the CASAS 
Online System have access to all menus and data 
functions, and not all users have access to data or 
rights to edit records. 

 

Visit the CASAS website for more information about Assessment and Database 
Management Features to understand ‘basic’ vs. ‘enhanced’ access to the CASAS 
Online System. 

 

Take a Highlights Tour to look at some menu features and to see how TE organizes menus. 

Step Screen Description 
1.  

 
 
 
 

• All data and reports display on the screen 
from accessing the Menu bar along top left. 

2.   

 

• Top right displays, 

o Logged-on User. 

o Application Version. 

o General screen Controls. 

o Pages tab to clear your screen(s). 

 

3.  

 
 
 
 

• Click the TE Icon at top left of your screen. 

• Before exiting TE, it’s best to –  

o Disconnect your TE Client to close 
connection with the server on your 
local machine. 

• Click Options… 

https://www.casas.org/training-and-support
https://www.casas.org/docs/support-documentation/assessment-and-database-management-features.pdf
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Step Screen Description 
4.  

 
 
 

• Look at the General tab. 

o Interactive Timeout Interval 

 Adjust # of minutes before 
the TE Client suspends 
activity. 

 Applies to TE Client on the 
local machine only. 

5.  

 
 
 

• Click the On Start tab. 

o Remaining WTUs 

 Set a TE Client reminder 
when # of WTUs reaches a 
minimum set by users. 

 Applies to TE Client on local 
machine only. 

6.  

 
 

• Click the Edit / View tab. 

o Name Options. 
 Set option for entering names. 
 Apply option to correct names. 
 Applies to TE Client on local 

machine only. 

• To close the Options window, 

o Click the Red X Box at top right. 

 

7.  

 

• Click the View menu. 

o Screen Display 

 Normal is the default. 

 Adjust for viewing on local 
TE Client. 

https://www.casas.org/training-and-support
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Step Screen Description 
8.  

 
 
 

• Highlight or click the Organization menu. 

o Sub-menus contain detailed 
information about the organizational 
setup of an online account. 

• Click the Records menu. 

o Menu Categories identify groups of 
lists with records for tracking 
program and student activity. 

o Sub-menus identify the type of 
records.  

9.  

 
 
 

• Highlight or click the Reports menu. 

o Menu Categories identify groups of 
reports that help programs meet a 
wide variety of reporting needs. 

o Sub-menus identify the type of 
report. 

10.  

 
 

• Highlight or click the Tools menu. 

o Sub-menus list operations for 
managing data. 

• Highlight or click the Help menu. 

o Release Notes are included with 
each update to the Online System. 

o Review Notes for important new 
features and enhancements as well as 
any necessary fixes. 

 

https://www.casas.org/training-and-support
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Finding Information 

The online system functions like a web browser to fetch information and display on the screen in 
tabbed pages. Using tabs as a navigational tool is a feature that allows you to switch between multiple 
pages of information. 

Understanding the Relationship of Records in TE 

TOPSpro Enterprise is a relational database that contains a collection of interrelated records, 
which stores information and relates records by a common element. In TE, that element is the 
identification field. For a student, that field contains the identification code unique to the learner 
that links all records related to the learner. The graphic below presents this concept. 

 

The Student Identification (ID) code provides the minimum information for TE to add a student 
record. The student Demographics record is the "parent" record for all other learner-related 
records. Every time you add another record, TE links the ID to the corresponding student, and 
creates a new record. These other records contribute additional information to the student and are 
the “child” records in the database. TE connects the parent and child records by ensuring that they 
all include one common variable – the Student Identification (ID) code. 

Customizing Lists of Records 

TE uses Listers to display lists of records. Each lister name indicates the information that it 
contains. Listers are like spreadsheets but in electronic form. You may sort, filter, add, hide, and 
organize columns, set advanced filtering options, print, and export the information displayed.

https://www.casas.org/training-and-support
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Using the student as an example, let’s customize the Demographics lister. 

Step Screen Description 
1.  

 
 

• From the Menu bar at top, 

• Click Records. 

o Select Students. 

o Click Demographics. 

2.  

 
 

• A tabbed page opens to the list of 
Demographics records with a Toolbar along 
the top. 

o Records display for students having 
activity in the Current Program Year 
(July 1 – June 30). 

o Sorts on Student ID. 

• Most Column Headers have Up/Down 
arrows and Filter icons. 

3.  

 
 

• To sort by Name, 

o Click the Name column UP arrow. 

• By default, the Name column sorts by First 
name. 

4.  

 

• Each list of records has its own default 
Schema, or Column Configuration. 

• You may change the configuration of 
columns and save the Schema on your TE 
Client. 

• To split the Name column into First, 
Middle, and Last name columns, 

o Point your mouse in the Name 
column header. 

o Right mouse-click. 

• From the drop-down menu listing 
additional columns available in the 
Demographics lister, 

o Click Show First Name. 

https://www.casas.org/training-and-support
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Step Screen Description 
5.  

 
 
 

• Now you will see the First name has its own 
column. 

• Repeat these steps to add a Middle name 
and Last name column. 

6.  

 
 
 

• Now that the Name column is split in to 
three columns for First, Middle, and Last 
name, you no longer need the column. 

• Right mouse-click in the Name column 
header. 

o Select Hide Full Name. 

 

7.  

 
 
 

• The Name column is now hidden from the 
list. 

• You may unhide any column to display 
again in the list of records. 

• Listers may be Reset to Defaults at any 
time. 

8.  

 
 

• Reordering columns will further customize 
the list of Demographics records for your TE 
Client. 

o Left click-and-hold your mouse in 
the Last Name column header. 

o While holding, drag the Last Name 
column left of the First Name, and 
then release your mouse. 

 

9.  

 

• The Demographics lister now displays 
names in a Last, First, and Middle name 
column configuration. 

https://www.casas.org/training-and-support


  Finding Information 
 

10 
Return to Table of Contents                                                                                                  © 2019 CASAS. All rights reserved. 
Training and Support 

 

Step Screen Description 
10.  

 
 
 

• In the Last Name column header 

o Click the UP arrow to sort 
alphabetically. 

11.  

 
 

1. First, sort on Last Name. 

2. Second, sort on First Name. 

3. Third, sort on Middle Name. 

 
Note! Adding Gender and DOB columns 
helps with identifying any duplicate 
records of the same student. 

 

• Suggestion: Configure and presort columns: 

1. Click the UP arrow in the Last Name 
column header. 

2. Click and hold the Shift key on your 
keyboard, and then click the UP arrow in 
the First Name column header. 

3. Click and hold the Shift key again, and 
click the UP arrow in the Middle Name 
column header. 

• Release the Shift key. 

12.  

 
 

• To save the configuration of your columns, 

o Click the More button from the 
Toolbar at top right for ‘more’ 
buttons. 

o Click Edit Schema. 

o Click Save. 

Remember!  
You can always reset listers to their default 
schema. 

 
13.  

 
 

• Check to confirm that your TE Client will 
display the Demographics lister in ‘your’ 
default Schema next time you open it. 

• To close the Demographics lister, 

o Click the Red X Box on the 
Demographics tab. 

https://www.casas.org/training-and-support
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Step Screen Description 
14.  

 
 
 
 

• You can also close several pages at the same 
time by clicking Pages at top right. 

• From the drop-down menu, 

o Click Close All Pages. 

o Or click individual Pages listed at 
bottom of the menu. 

15.  

 
 
 
 

• To reopen the Demographics lister, go to 

 Records > Students > Demographics 

• The list of Demographics records should 
display as the saved default Schema on your 
TE Client. 

16.  

 
 

Note! 

• You may also name different Schemas and 
access them from the Toolbar at top of the 
list 

o Click the (Default) window down 
arrow and select a saved Schema. 

 

https://www.casas.org/training-and-support
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Using the Navigator 

Let the TE Navigator be your guide! In listers, the Navigator links all ‘child’ records related to the 
‘parent’ record and displays them in a list to navigate easily between them. The report setup 
Navigator gives quick access to listers to refine information to include in the report. 

The Navigator will also guide you to adding ‘child’ records to ‘parent’ records by prepopulating 
key fields from the ‘parent’ record. When entering data manually, it is recommended to use the 
Navigator for data-entry accuracy. 

Using the student as an example, let’s explore ‘child’ records and see how many are linked to the 
student’s ‘parent’ Demographic record through the Navigator. 

Step Screen Description 
1.  

 
 

• Filter for a Student with your First or Last 
Name. 

o Click the First or Last Name column 
Filter icon. 

o Enter your First Name. 

o Click OK. 

2.  

 
 

• The Demographics lister may or may not 
display a record of a student having your 
First or Last Name. That’s Ok!  

o Filter for a friend or any other name 
instead. 

o Double click to open the Highlighted 
record. 

3.  

 

• A new tabbed page opens to a split screen 
with the – 

o Record Navigator at left. 

o Student Information at right. 

• Edit/View contains the ‘parent record’ data 
for the student. 

• Remaining selections on the Navigator 
represent ‘child records.’ 

https://www.casas.org/training-and-support
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Step Screen Description 
4.  

 
 

• Clicking the different options from the 
Navigator provides views of a variety of 
information about that student. 

 

Remember! 

• The student’s unique Identification (ID) 
code is what links all of the records assigned 
to the student, and supplies the minimum 
information TE needs to create a student 
Demographic record. 

5.  

 
 

• From the Navigator at left, 

o Click In Program Years. 

• At right lists records for each program year 
in which the student has dated activity. 

• A Program Year is defined as July 1 through 
June 30. 

6.  

 
 

• From the Navigator at left, 

o Click Student Records. 

• The records listed at right are of all dated 
activity that occurred for the student during 
the program year. 

7.  

 
 

• From the Navigator at left, 

o Click Class Enrollments. 

• This list will only include one record for 
each class in which the student is enrolled. 

https://www.casas.org/training-and-support
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Step Screen Description 
8.  

 
 

• From the Navigator at left, 

o Click Class Records. 

• This section includes separate records of all 
class related activity for the student. 

9.  

 
 

• From the Navigator at left, 

o Click Program Enrollments 

• This section will only include one listing for 
each program in which the student is 
enrolled. 

10.  

 
 

• From the Navigator at left, 

o Click Program Records. 

• This list includes separate records of all 
program related activity for the student. 

11.  

 
 

• From the Navigator at left, 

o Click Tests. 

• This is a list of tests taken by the student. 

12.  

 

• Return to Edit/View to edit Student 
Information. 

https://www.casas.org/training-and-support
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Editing Student Information 

Step Screen Description 
13.  

 
 
 

• By default, the Edit/View page opens in 
View mode. 

• To edit a student ID, 

o Click the Pencil icon in the 
Identification section and Change to 
Edit Mode. 

 

14.  

 
 
 

• Type in the Student ID field and change the 
ID. 

• From the Toolbar at top. 

o Click Save. 

 

Note! A change to the Student ID will 
simultaneously edit all ‘child’ records linked 
to the student. 

15.  

 
 
 

• To see how that works,  

o Click Tests from the Navigator. 

 

 

 

• You may notice that the ID does not appear 
to have changed. 

 

• Continue on to solve the mystery!... 

https://www.casas.org/training-and-support
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Step Screen Description 
16.  

 
 
 

• At top right of the student’s Tests lister, 

o Click Refresh. 

• This will ‘refresh’ the page on your TE 
Client. 

17.  

 
 
 

 

• Voila! 

o Now you see that the ID on all Tests 
linked to the student are changed. 

 

 

 

18.  

 

• To clear your screen, 

o Click Pages at top right. 

 Select Close all Pages. 

 

 

https://www.casas.org/training-and-support


Sites   
 

© 2019 CASAS. All rights reserved.                                                                                                  Return to Table of Contents 
Training and Support 17 

 

Adding Records Manually 

The CASAS Online System offers four methods for adding records to your online account through both 
applications – eTests Online together with TE Online. 

 eTests Online 

1. Sessions – for testing and collecting demographic information 

 TE Online 

2. Manual data entry – using the keyboard and mouse 
3. Scanning – using an optical mark scanner 
4. Importing – from a 3rd Party System or fillable Import Template 

 

Steps to Add Sites 

Sites are part of the organizational structure of an online account and represent physical locations 
where testing, instruction, and training take place. A site may serve learners in multiple instructional 
and training programs. Agencies may add Sites to their online account at any time. 

eTests Site 

Any Site using eTests Online must comply with all testing requirements in each lab within a Site as 
outlined in the Online Implementation Agreement training. 

• Web-test units (WTUs) must be available in an online account to enable an eTests Site. 
• Sites must be enabled for eTests to register computers and administer tests. 

Step Screen Description 
1.  

 
 

• From the Menu bar at top, 

o Click Organization. 

 Select Sites. 

https://www.casas.org/training-and-support


  Sites 
 

18 
Return to Table of Contents                                                                                                  © 2019 CASAS. All rights reserved. 
Training and Support 

 

Step Screen Description 
2.  

 
 
 

• A new tabbed page opens listing the Sites 
setup in the online account. 

• Sites that use eTests Online are identified as 
an eTests Site. 

• To be an eTests Site, agencies complete a 
"Going Live" Checklist , which includes: 

o Online Implementation Agreement 
o Coordinator Certification 
o Proctor Certification 
o Order web-test units (WTUs) 

• From the Toolbar at top left, 
o Click New. 

3.  

 

• A new tabbed Page opens to add 
information about the new Site for your 
agency. 

• Sites are added to Containers, which 
‘contain’ records of activity occurring at that 
site. 

o Your Agency is the ‘parent’ container 
for your online account. 

4.  

 

• Sites are ‘child’ records of your Agency. 

• Sites are typically added to the ‘parent’ 
container but may also be a Sub-Site. 

• The determination of ‘where’ to add a new 
Site depends on How? you plan to track and 
record outcomes. 

• Click the Container field down-arrow. 

o Select the Container to add the new 
Site. 

https://www.casas.org/training-and-support
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Step Screen Description 
5.  

 
 
 

• For Site Identification, 

o Enter the Site ID. 

o Enter the Site Name. 

o Check eTests Site –  

 Only check if you plan to use 
CASAS eTests Online at the Site 
and WTUs are available for 
online test administration. 

• From the Toolbar at top, 

o Click Save. 

6.  

 
 
 

• To close the new Site record, 

o Click the Red X Box on the Site tab. 

7.  

 
 
 

• This returns you to the Sites lister where 
you will see the new Site in the list of 
records. 

8.  

 

• Click the Red X Box on the Sites tab and close 
the lister. 

 

https://www.casas.org/training-and-support
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Steps to Add and Manage Users 

Access to the CASAS Online System requires a User record with login credentials. Users are part of the 
organizational structure of your online account. When setting up a new account, CASAS establishes 
one User for the agency with rights to manage data and grant User access to TE Online and/or eTests 
Online for other staff as appropriate. When adding Users to your online account, CASAS recommends 
adding records at the agency level for ease with managing records and user access. 

Access to TE Online 

Access to eTests Online 

Step Screen Description 
1.  

 

• From the Menu bar, 

o Click Organization. 

 Select Users. 

2.  

 

• A tabbed page opens to the list of User 
records. 

• From the Toolbar at top left of the list. 

o Click New. 

• May be granted to any staff as appropriate. 
• eTests Online coordinator and proctor certification is not required for staff access TE Online. 

• May only be granted upon confirmation of coordinator and/or proctor certification. 
• The agency must maintain copies of certificates on file. 

o Coordinator Certification – Staff responsible for online testing management. 
o Proctor Certification – Staff responsible for online test administration. 

https://www.casas.org/training-and-support
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Step Screen Description 
3.  

 
 

• Check Link with existing personnel –  

o When a Personnel record exists in 
your online account. 

o If a record does not exist, you will have 
the option to link accounts when 
adding the Personnel record. 

4.  

 
 

• Click the Container field down-arrow. 

o Select the container to add the new 
User record. 

Note! Add Users at the Agency level when 
linking accounts with Personnel records. 

5.  

 
 

• User Identification will be the login 
credentials for the new User. 

o Enter a Work e-mail address as the 
user name (recommended). 

o Enter a temporary Password. 

 Users are prompted to 
change their password the 
first time they log in. 

6.  

 

• Add the new User to an Access Group. 

o You have three options to do this. 

• Click the Group field down-arrow, 
1. Type to Search for the Group. 
2. Scroll to Select the Group. 
3. Select [Group] from Lister. 

7.  

 

• After selecting an Access Group, 

o Click Add at right of the selected 
Group. 

 

1 

2 

3 

https://www.casas.org/training-and-support
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Step Screen Description 
8.  

 
 

• If the new User will need access to eTests 
Online to: 

o Manage online testing (Coordinator). 

o Administer online tests (Proctor). 

 Add the new user to the 
access group that matches 
with their certification. 

 

9.  

 
 

• Add Contact Information for the new User. 

• The minimum information required for 
adding an account is: 

o First Name. 

o Last Name. 

o Email 

 

 
10.  

 
 
 

• No other setup is needed for the new User 
when added to Access Groups. 

• From the Toolbar at top, 

o Click Save. 

11.  

 
 

• Click the Red X Box on the User record tab 
and return to the lister. 

12.  

 

• Use the First/Last Name column filter to 
locate the new User among the list of 
records. 

https://www.casas.org/training-and-support
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Step Screen Description 
13.  

 
 

• Click the Red X Box and close the Users 
lister. 

 

Defining Group Access Rights 

For ease with managing Users through Access Groups, establish and maintain groups at the agency 
level (i.e., parent container). 

Step Screen Description 
1.  

 

• From the Menu bar, 

o Click Organization. 

 Select Access Groups. 

2.  

 

• The tabbed page opens listing Groups for 
Agencies to manage User Access to TE. 

• TE Data Managers may –   

o Edit, Rename, or Duplicate the 
default set of groups added by 
CASAS when setting up a new 
online account. 

3.  

 

• TE Data Managers may also –   

o Add new TE Access Groups to 
manage users based on their role at 
the Agency, such as a School 
Counselor or the Registrar. 

https://www.casas.org/training-and-support
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Step Screen Description 
4.  

 
 

• Groups have access to TE according to the 
rights enabled in three areas: 

1. Menu Access Rights 

o Defines access to menus and 
submenus. 

2. Container Access Rights 

o Defines access to sites and sub-sites. 

3. Data Access Rights 

o Defines read-only access, or rights to 
create, update, and/or delete data. 

 

5.  

 
 

• Granting Teachers access to TE requires 
having a User record linked with a 
Personnel record to identify their 
Functional Role as the teacher for their 
classes. 

• Teachers may, 

o Generate Reports for their own 
classes. 

o Manage their Class Enrollment. 

o Record Attendance. 

o View Test results taken by students 
enrolled in their class. 

 

 

 

Ask CASAS! To apply the default set of Access Groups to your online account 

 

 

For more information about Access Groups is available from the training materials 
library on the CASAS website at Home > Training and Support. 

 

https://www.casas.org/training-and-support
https://www.casas.org/
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Steps to Add and Link Personnel Records 

Personnel records are part of the organizational structure of an online account and include 
Registration, Functional Role, Employment Record, and Professional Status information. 

Personnel Registration 

Step Screen Description 
1.  

 
 
 
 

• From the Menu bar. 

o Select Personnel. 

 Click Registration. 

2.  

 
 
 
 

• To add a new Personnel record, 

o Click Registration. 

3.  

 
 
 

• A tabbed page opens to the list of Personnel 
records in your online account. 

• From the Toolbar at top left of the list, 

o Click New. 

https://www.casas.org/training-and-support
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Step Screen Description 
4.  

 
 
 

• When a User record exists in your online 
account, 

o Check Link with existing user. 

5.  

 
 
 

• Click the Container field down-arrow. 

o Select the Agency level 
(recommended) 

o Or Site level. 

6.  

 
 
 

• You have three options to select an existing 
User. 

• Click the User field down-arrow, 

1. Type to Search for the User. 

2. Scroll to Select the User. 

3. Select [User] from Lister. 

7.  

 
 
 

• When the User is located, 

o Click on the User to select. 

1 

2 

3 
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Step Screen Description 
8.  

 
 
 

• Personnel Information fields auto-populate 
after selecting and linking the User. 

o Enter an Agency Personnel ID. 

9.  

 
 
 

• From the Toolbar at top, 

o Click Save. 

10.  

 
 

• The new Personnel record page splits 
automatically with 

o Personnel Information at right 

o Navigator at left to add and access 
Personnel  records. 

• Click the Red X Box on the Registration tab 
and return to the Personnel record. 

 

Functional Roles 

Functional Roles identify personnel involved in the administration and teaching of adult learners. 
Personnel may have more than one Functional Role within the agency. Adding Functional Roles for 
teachers gives them access to their classes at any time from any location with Internet connection. 

Step Screen Description 
1.  

 

• From Navigator at left of the Personnel 
Information record, 

o Click Functional Roles. 

• To add a Functional Role for the Personnel 
member, 

o Click New at right. 
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Step Screen Description 
2.  

 
 
 
 

• A new tab opens to input Functional Role 
Information in three sections. 

1. Personnel information, 

2. Container to associate the role. 

3. Role Identification. 

• Personnel and Container fields auto-
populate when using the Navigator to add 
records. 

3.  

 
 
 
 

• To link the Personnel member with a Class, 

o Click the Class Definition field 
down-arrow and 

 Type to search. 

 Scroll to select. 

 Select from Lister  

o Select the Class. 

4.  

 
 
 
 

• If the Personnel member is not a teacher, 

o Leave “No selection” in the Class 
Definition field. 

• Special Program will auto-populate if 
defined for the selected class. 

5.  

 

• For Role Identification, 

o Select Administrator, Scorer, or 
Teacher. 

o Select the Start Date when the role 
begins. 

o Leave End Date empty if the role 
will continue across program years. 
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Step Screen Description 
6.  

 
 
 

• From the Toolbar at top, 

o Click Save. 

7.  

 
 
 

• Return to the Personnel record. 

o Click the Red X Box on the 
Functional Role tab and return to 
the Personnel record. 

8.  

 

• The Functional Role record is now listed 
with the Personnel record. 

 

Note! Personnel may have more than one 
Functional Role at the agency. 

 

Employment Records 
The next record to add for Personnel is information about their employment. Personnel may have 
more than one Employment Record to identify different types of employment within the agency. 

Professional Status 
The last record to add for Personnel is information about their professional status.  

 

Detailed steps for adding Personnel Employment and Professional Status records 
are available from the training materials library on the CASAS website at Home > 
Training and Support. 
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ACTIVITY: Access the New Teacher’s Class 

Step Screen Description 
1.  

 
 

• At top left of your screen, 

o Click the TE icon. 

o Click Disconnect. 

2.  

 
 

• Log in as the Teacher. 

o Enter Credentials. 

o Click Connect. 

3.  

 
 

• From the Menu Bar at top, 

o Click Organization. 

o Click Classes. 

o Click Instances. 

4.  

 
 

• The teacher’s Class will display in the list. 

• Double-click on the Class to open the 
record. 

5.  

 
 

• With access to Classes, teachers can –  

o Record Attendance. 

o Enroll students and update their 
Status in class. 

o View Tests taken by students 
enrolled in the class. 

o Generate Student & Class Reports. 

6.  
• Note! For training, you will need to Disconnect from TE and then Connect again with 

your Admin account to proceed with the next steps. 
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Steps to Add Student Records 

The recommended approach to adding and editing Student records is from the Demographics list of 
records. Using the Navigator to add or edit ‘child’ records will ensure data entry accuracy with 
prepopulated ‘parent’ information. 

Step Screen Description 
1.  

  
 
 
 

• From the Menu bar, 

o Click Records. 

 Select Students. 

 Click Demographics. 

2.  

 
 
 
 

• From the Toolbar at top left of the 
Demographics page, 

o Click New. 

3.  

 
 

Note! Use eTests Online to collect and ‘fill-
in’ remaining Demographics, or add 
students in TE automatically. 

 

• A new tabbed page opens to input Student 
Information. 

o Select the Site where the student will 
have activity. 

• Enter the minimum (recommended) 
Identification. 

o Student ID. 

o First/Last Name. 

o Gender. 

o Birth Date. 
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Step Screen Description 
4.  

 
 

• Click Save from the Toolbar at top. 

• If adding no other record for the Student at 
this time, the new record will not display in 
the list of Demographic records 
automatically. 

o This is because the Student has no 
activity in the current program year 
(i.e., no In Program Years record.) 

• Adding any record from the Navigator, such 
as results from a paper Test, will add the In 
Program Years record automatically. 

• Adding paper Test results also prepares the 
online system to give the student the next 
assigned test in eTests Online automatically. 

5.  • Continue with steps to add a Test record for the new student. 
 

 

Steps to Add Test Records 

Use the Navigator from the student’s Demographics record to add a Test record. Again, this 
recommended approach will ensure data entry accuracy with prepopulated ‘parent’ information about 
the student. 

Step Screen Description 
1.  

 

• From the Navigator at left, 

o Click Tests. 

• From the student’s Tests lister, 

o Click New. 
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Step Screen Description 
2.  

 
Note! 
Assigning a Class to the Test Record is no 
longer necessary or required because TE tracks 
student activity through their ‘unique’ ID. 

• A new tabbed page opens to input Test 
information. 

• The Test record prepopulates with Site, 
Program Year and Student fields 
automatically. 

• Enter the Assessment Date. 

o Use the drop-down calendar 

o Or type the Date. 

3.  

 
 
 

• For Assessment Information, 

o Click the Form field down-arrow, 
and select a Test Form. 

 Type to Search. 
 Scroll to Select. 
 Select from Lister. 

 

Scoring Option #1 

• Check Score Override. 

o Enter the Raw Score. 

• Scale Score auto-populates after saving the 
record. 

Scoring Option #2 
4.  

 
 

• You also have the option of entering item 
responses if you plan to generate 
performance reports from test results. 

o Leave Score Override unchecked 

o Enter Responses to each test item. 

• Raw and Score Scale auto-populate after 
saving the record. 

• Click Save from the Toolbar at top. 

1 

2 
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Step Screen Description 
5.  

 
 
 
 

• Click the Red X Box on the Test record tab 
and return to the student’s Demographics 
record. 

6.  

 
 
 
 

• You will now see the new record in the 
student’s Tests lister. 

o Click Refresh in the Tests lister 
Toolbar if needed to display Tests. 

7.  

 
 
 
 

• Click the Red X Box on the Student record 
tab and return to the Demographics lister. 

• Click the Filter icon in the Student ID 
column. 

o Enter the Student ID. 

o Click OK. 

8.  

 
 

• The new Student record is now in the 
Demographics list of records for the current 
program year. 

 

 
ACTIVITY: Sign back on as your fictitious Teacher to Enroll the Student in your Class and see the 
student’s Test record. Note: Student record must be at the Class Site to enroll and see Tests taken at any 
site. 
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Tracking Results 

Pre- and post-test pairs must always be from the same test modality. 

Pretests 

Administer pretests as soon as feasible upon entry into the program and before the occurrence of 
any substantial instructional intervention. 

All students with 12 or more hours of instruction must be pretested to include in the Federal Tables. 

Students should be assessed in the areas that are the focus of instruction, using the appropriate 
CASAS standardized test in reading, math, listening comprehension, or writing.  

• Required skill areas for ABE/ASE are reading and math. 
• Required skill areas for ESL are reading and listening. 

Post-tests 

Administer post-tests using the next-assigned test forms. 

• At the end of a semester, term, quarter, or other substantial block of instruction to document 
learning gains.  

• Post-test scores obtained at the end of a semester or other reporting period may serve as a 
pretest for the next semester or reporting period, if the interim does not exceed four months 
for continuing students. 

Test scores outside the range 

If a student achieves a score below the accurate range (*) on a pretest, 

• The student must be re-tested with a test from the next lower level for accurate placement. 

If a student achieves a conservative estimate () score on a pretest, 

• The student must be re-tested with a test from the next higher level within a week of the 
initial pretest. 

• The new assessment score replaces the conservative estimate score. 

• The replaced test record should be marked as ‘Retested’ in the database to exclude from 
being reportable and to retain historical data. 
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If a student achieves a conservative estimate () score on an appropriate level post-test, 

• The student has sufficiently demonstrated skill gain and should not be re-tested until the 
next scheduled assessment cycle. 

• At the next scheduled assessment cycle, the student must receive a test from the next higher 
level. 

If a student achieves a conservative estimate () score on a Level C 980 Listening pretest or post-test, 
the student has demonstrated skill proficiency and continued testing in listening is not required. The 
student should continue testing in reading until skill proficiency is demonstrated at which time the 
student should be considered for transitioning to an ABE program. 
 

Multiple Modalities Paired Tests 

What if a student has two sets of pretest and post-test scores, such as one in reading and one in listening? 

• The pretest and post-test pair with the lowest accurate pretest score determines benchmark 
attainment. 

• This satisfies the Federal requirement to address the student’s ‘highest area of need.’ 

What if the student has two pairs of tests, but one pretest/post-test pair is in an ESL class and the other pair 
is in ABE?  

• This is the one exception to what is stated above. 

• If a student has tests in multiple programs, then TOPSpro Enterprise follows an established 
hierarchy, which is: 

1. ESL/ELL – English as a Second Language/English Language Learner 

2. ABE – Adult Basic Education 

3. ASE – Adult Secondary Education 

• So in the example above, TE would select the tests that are assigned to ESL. 
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Customizing the Tests Lister 

Sometimes the obvious is the best place to start tracking results! The Tests Lister displays all current 
tests in your account. This is the ‘go-to’ Lister for monitoring the validity of test results. The default 
schema in the Tests Lister includes columns for test scores below accurate range and conservative 
estimate scores. Customizing this Lister further will help to detect test-taker behavior for tests 
administered with eTests Online such as: 

 

Follow these steps to customize the Tests Lister to help identify suspicious test results worth 
investigating. 

Step Screen Description 
1.  

 
 
 
 
 

• From the Menu bar at top, 

o Click Tests. 

 

2.  

 
 

• The Tests lister default schema: 

o Sorts on most current Assessment 
Date. 

• Includes columns for: 

o Form 

o Scale Score 

o Accurate (scores) 

o Conservative Estimate (scores) 

 

• How much time did the student spend on the test? 
• Was the student speeding through the test? 
• Did the student finish the test within ‘normal’ test time? 
• Did the student run out of time and the test ‘timed out’? 

https://www.casas.org/training-and-support


  Test Records 
 

38 
Return to Table of Contents                                                                                                  © 2019 CASAS. All rights reserved. 
Training and Support 

 

Step Screen Description 
3.  

 
 
 
 
 

• To filter for scores below Accurate range, 

o Click the filter icon in the Accurate 
column. 

• From the drop-down menu, 

o Check No. 

o Click Ok. 

 

4.  

 
 
 
 
 
 

• Scores below Accurate range are invalid. 

o Retesting is required for both pre- 
and post-tests. 

• Invalid scores are not reportable. 

• The test record should not be deleted from 
the database in order to retain historical data 
for tracking and accountability. 

 

5.  

 
 
 
 
 

• Check the Red X Box on the Accurate 
column filter. 

• This removes the column filter and returns 
the Tests lister to its last configuration. 

 

6.  

 

• To filter for Conservative Estimate scores, 

o Click the filter icon in the 
Conservative Estimate column. 

• From the drop-down menu, 

o Check Yes. 

o Click Ok. 
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Step Screen Description 
7.  

 
 
 
 

• Conservative Estimate scores are valid and 
reportable. 

o Retesting is required for pretests. 

o Check with your State Assessment 
Policy for further guidance if/when 
retesting is required for post-tests. 

 

8.  

 
 
 
 
 
 
 
 
 

• Add the Retested column to identify Tests 
excluded from reports and 3rd Party Exports. 

o Right mouse-click in the column 
header. 

• From the drop-down menu of additional 
columns, 

o Click Show Retested to produce a 
list of potential retakes. 

 

9.  

 
 
 
 

• Click the filter icon in the Retested column. 

• From the drop-down menu, 

o Check Yes. 

o Click Ok. 

 

10.  

 

• If students Retested, those test records 
would appear in the list. 

• If no tests appear, that’s worth investigating! 

• Check the Red X Box to remove both filters 
and move on… 
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Step Screen Description 
11.  

 
 
 
 
 
 

• Right-mouse click in the Retested column. 

o Select Hide Retested. 

 

12.  

 
 
 
 
 
 

• Right-mouse click in the Accurate column 
header. 

o Select Show Assessment Duration 
in Minutes. 

 

13.  

 
 
 
 
 

• The Duration column tells you the total 
number of Minutes the student spent taking 
the test. 

• When students spend less time than 
appropriate for the test form level and 
modality, this is another area to address. 

 

14.  

 
 
 
 
 
 

• To gain additional insight about test-taker 
behavior while taking the test, 

o Right-mouse click in the Scale Score 
column header. 

o Select Show Raw Score. 

• Take note of Raw Score results compared to 
the Duration minutes.  
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Step Screen Description 
15.  

 
 

• If Duration is low and Raw score is low, 

o There is a high probability the 
student clicked through the test 
rapidly. 

o Even though results may be 
Accurate, retesting should be 
considered. 

• If Duration is low and Raw score is high, 

o That’s a good indicator the test was 
too easy for the student. 

o And if Conservative Estimate is 
‘Yes’, that’s confirmation the student 
should be retested. 

 

16.  

 
 
 

• Another column to consider adding,  

o Show Terminate Test Reason. 

• This will tell you more about the timing of 
the test. 

17.  

 
Remember!  
You can always reset listers to their default 
schema. 

• If the additional columns and configuration 
of columns is something you want to save 
for when you reopen the Tests Lister, 
remember to save the schema! 

o Click More from the Toolbar at top 
right for ‘more’ buttons. 

o Click Edit Schema. 

• Save as ‘your’ Default schema on your TE 
Client, or enter a Schema name. 

o Click Save. 
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Steps to Generate Reports 

Reports from TE Online are always available for you to generate for your class. The CASAS eTests 
report category gives you access to reports directly related to web-based testing. The Test Results 
report category gives you access to performance reports for students and classes. The State Reports 
category gives you access to monitor student gains (currently available for CA only). 

   

Whenever you select any report from the Reports menu, you are presented with the Report Setup 
screen, also referred to as the Report Generator. Each setup screen consists of two main sections. 

1. With the Report Setup Toolbar along top of the setup screen, you can Generate the report. 
 

2. With the Report Setup 
Navigator, you can: 

• Define settings using the 
General Settings page. 

• Filter the initial 
population using 
available listers. 

 
With the report displayed, use the 
Toolbar to, 

• Print. 

• Export to save as a PDF, or 
other file type, on the local 
machine. 

• Keep Session to save an 
electronic copy in the TE 
Reports Manager. 

Tip! Before saving reports in TE, use General Settings and Name 
the report. 

o Click Edit Session. 

• Edit the Session Name in General Settings. 

o Click [Re]Generate. 

• This will help to locate the report in the Reports Manager. 

 

2 

1 
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CASAS eTests Reports 

Next-Assigned Test (NAT) 

Access TE: Reports > CASAS eTests > Next‐Assigned Test 

 

TE TIP! 
1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment. 
2. Use the Navigator to select a Class Instance and generate the NAT. 

This report is designed to take the legwork out of deciding which test to administer to individual students. TE 
makes this process easier with the Next‐Assigned Test (NAT) report. 

TE searches the database to find the last test a student took in all classes across sites. Based on the form and score 
of the last test taken, TE assigns the next test form for tests in each modality that a student tested in such as 
reading, math and listening. 

This report should be used along with other measures, such as hours of instruction, student class work, and 
teacher judgment. Administrators, database managers, and teachers should remember that the number of hours 
of instruction between pre‐ and post‐test might affect a decision to post‐test with the NAT or override the NAT at 
the same level or at the next higher level. In addition, the following should be taken into consideration: 

• CASAS does not recommend a lower level form at post‐test unless the pretest score was inaccurate. 

• Extended range forms (081RX or 082RX) are utilized differently than other forms because they are 
measured across levels.  
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Personal Score Report (PSR) 

Access TE: Reports > Test Results > Skills Profile > Individual Skills Profile 

 

1. Use the Navigator to select a Test and generate the PSR. 

This is a copy of the Personal Score Report that students see displayed on the testing station screen 
after ending a test. Information displayed to the student may be customized to remove the levels bar 
and skills description. 

The report gives a summary of the student’s results on a given form to provide them with immediate 
feedback after completing a test. 

This is an optional report in eTests and if enabled, students may print the PSR. 

 

 

https://www.casas.org/training-and-support


Skills Profile   
 

© 2019 CASAS. All rights reserved.                                                                                                  Return to Table of Contents 
Training and Support 45 

 

Skills Profile Reports 

Student Individual Skills Profile (ISP) 

Access TE: Reports > Test Results > Skills Profile > Individual Skills Profile Summary 

 

1. Use the Navigator to select a Student from In Program Years and generate the ISP. 

The Individual Skills Profile (ISP) shows how an individual student performed on the most recent reading, 
math, and listening test. 

The report displays the CASAS Competency Content Areas and CASAS Basic Skills Content Standards 
Categories assessed for each test modality. 

The Skills Profile identifies by percentage the number of competencies within a content area the student 
answered correct; and by percentage, the number of underlying basic skills embedded in CASAS Competencies. 

At far right is an optional setting that you may add to the report to indicate Grade Level Equivalency. 

The HSE Predictor is included in the report when a test modality score is 236 and above to indicate the likelihood 
of the student passing a High School Equivalency Exam. 

ACTIVITY: 
1. Drill down to Test Item and Competency 
2. Drill down to Test Item and Content Standard  
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Skills Profile – Class Summary (ISPS) 

Access TE: Reports > Test Results > Skills Profile > Individual Skills Profile Summary 

 

The Individual Skills Profile (ISP) Summary shows how groups of students performed on the same 
form level with their most recent reading, math, and listening test. 

As with the ISP, this report also displays CASAS Competency Content Areas and CASAS Basic Skills 
Content Standards Categories assessed for each test modality at the given form level. 

The Skills Profile identifies by percentage the number of competencies within a content area, and by 
percentage the number of underlying basic skills embedded in CASAS Competencies that the students 
answered correct. 

ACTIVITY: 
1. Drill down to Form Level to see the list of student functioning at that level. 
2. Drill down to Total Tests to see the list of tests students took at the Form Level. 

1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment. 
2. Use the Navigator to select a Class Instance and generate the ISPS. 
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Competency Performance Reports 

Competency Performance – Student (SCP) 

Access TE: Reports > Test Results > Competency Performance > Student Competency Performance 

 

1. Use the Navigator to select a Test and generate the SCP report. 

The Student Performance by Test Item & Competency report shows how an individual student responded on a 
given test form. This report displays by test item the competency number and statement, the task area for how the 
item was presented, and if the student answered the item correct. 

This is an excellent report to give to individual students to provide them with feedback for their performance on 
the test and the life skills competencies they need to learn. 

Competency statements can be more meaningful to students than raw or scale scores. 

How to use: 

• Target weak areas of understanding. 

• Spend less time on mastered competencies. 

• Evaluate retest needs if the sale score falls below accurate range, or the student ran out of time to 
complete the test. 

• Use the report to discuss the competency areas of need with the student.  
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Competency Performance – Class (SCPS) 

Access: TE > Reports > Test Results > Competency Performance > Competency Performance 
Summary 

 

The Class Performance by Test Item & Competency report gives a summary of how students in the class 
performed on a given test. 

With this report, an instructor is able to see a percentage by which each item, or each competency, was 
successfully completed by the students who took the test. 
How to use: 

ACTIVITY: Drill down to the list of students who completed a given form. 

1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment. 
2. Use the Navigator to select a Class Instance and generate the SCPS. 

• Identifies the position of each test item on the form. 
• Indicates the percentage by which the number of students who took the form answered correct. 
• Includes the competency number and statement assessed per test item. 
• Specifies the task area for presenting each test item. 

• Teachers use this report to inform instruction and plan lessons. 
• Teachers also use this report to target the areas of greatest need to prepare their students for the next 

testing cycle. 
• Teachers can identify the students who took a given test and group instruction to work on competencies 

the students need most to learn. 
• Teachers can share the results with the class as a whole. 
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Content Standards Reports 

Content Standards – Student Performance (SCS) 

Access TE: Reports > Test Results > Content Standards > Student Content Standard Performance 

 

The Student Performance by Test & Content Standard report is similar to the Student Performance by 
Test Item & Competency report except this report indicates the students’ performance in each content 
standard by showing the percentage of correct responses to items that relate to each basic skills content 
standard. 

The SCS report has two Layout options. 

 

  

1. Use the Navigator to select a Test and generate the SCS report with its default Layout setting 
for Test & Content Standard. 

1. Test & Content Standard (default) 
2. Test Item & Content Standard 

https://www.casas.org/training-and-support


  Content Standards 
 

50 
Return to Table of Contents                                                                                                  © 2019 CASAS. All rights reserved. 
Training and Support 

 

 

Content Standards – Student Performance (SCS) 

Access TE: Reports > Test Results > Content Standards > Student Content Standard Performance 

 

This alternate version of the Student Performance by Test Item and Content Standard report 
combines both competencies and associated basic skills content standards on the test in one report. 

  

1. Return to the Report Setup Screen and select Test Item & Content Standard for the Output 
Layout. 

2. Regenerate the SCS report. 

• Each row contains a reading content standard. 
• The columns contain a test item and corresponding competency number(s). 
• Each check mark indicates the student’s correct response to the test item that relates to that 

particular content standard. 
• Each red “X” indicates the student’s incorrect response to the item relating to the content 

standard. 
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Content Standards – Class Performance Summary (SCSS) 

Access TE: Reports > Test Results > Content Standards > Content Standard Performance Summary 

 

The Class Performance by Test & Content Standard report is also similar to the Class Performance by 
Test Item & Competency by giving a summary of how students in the class performed on a given test. 

With this report, instructors are able to see a percentage by which each item or each content standard 
was successfully completed by the students who took the form. 

How to use: 

ACTIVITY: Drill down to the list of students who completed a given form. 

1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment. 
2. Use the Navigator to select a Class Instance and generate the SCSS. 

• Teachers can determine from the report the basic skills content standards in which the students 
performed well. 

• Teachers use this report to inform instruction and plan lessons to target areas of need to prepare 
students for the next testing cycle. 

• Teachers can identify the students who took a given test and group instruction to work on 
content standards the students need most to learn. 

• Teachers can share the results with the class as a whole. 
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Learning Gains Reports 

Learning Gains – Student (LG) 

Access TE: Reports > Test Results > Learning Gains > Student Learning Gains 

 

The Learning Gains First to High report computes progress (or setbacks) from the first test to the highest test 
given (in any class at any site) for a particular student. 

The first test from which progress is measured is considered the anchor test. If a student changes classes several 
times, TE will locate the student’s highest test and match it with the first test.  

The benefit is that a teacher does not need to know all other classes the student is taking to compute the gains.  

TE also matches tests by form type. For example, if a student takes reading, listening, and math test, the report 
generator will selectively match reading tests to reading tests, listening tests to listening tests, and math tests to 
math tests. 

How to use: 

ACTIVITY: Generate the report again using any of the other Learning Gains Types.  

1. Use General Settings > Special Options and set Display Class Based On > Class Enrollment. 
2. Use the Navigator to select a Class Instance and generate LG with its default settings. 

• Use this report to determine the highest gain a student (or the class as a whole) received on a particular 
form type across classes.  

• Use this report to see which students have a pretest, but no post-test.   
• Use this report to see which students should be retested due to invalid test scores or high end 

conservative estimate scores.  
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Learning Gains – Class Summary (LGS) 

Access TE: Reports > Test Results > Learning Gains > Learning Gains Summary 

 

Use the Navigator to select a Class Instance and generate the LGS. 

This report is designed to show, by Instructional Program and Modality (Reading, Math, Listening), the 
average gains (or setbacks) achieved between the scale scores of the First and the Last tests taken (not 
necessarily highest) within a defined period. 

How to use: 

ACTIVITY: Drill down to the list of students who took the tests. 

1. In General Settings > Output Parameters Layout, set Display Mode. 
2. In General Settings > Special Options, set Display Class Based On > Class Enrollment. 

• Determine the greatest amount of testing being done in different modality areas and Programs 
in a class. 

• Administrators can see how well, on the average, that gains are being accomplished from class 
to class for each Instructional Program by modality. 

• Teachers can compare their own class Learning Gains reports with other classes to see how well 
their own students compare 
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Test Response Reports 

Test Response – Class Profile (CPL) 

Access: TE > Reports > Test Results > Test History > Student Test Summary 

 

1. Use the Navigator to select a Class Instance (for test) and generate the CPL. 

The Class Profile is a legacy report that is also included as a worksheet in some older Test Administration 
Manuals. This report requires a class assigned to the test record for the report to generate. 

The Class Profile report shows teachers how individual students answered questions on specific tests 
within a specific class. The Class Profile report gives information at a glance on: 

How to use: 
• Determine if all students have mastered specific competencies 
• Determine competencies that still need attention 
• Identify students who have taken the same test twice within the date range (listed twice) 

• Individual student achievement 
• Class average 
• Total number of students 
• Correct (+) and incorrect (‐) item responses as well as blank (!) responses 
• Competency number for each test item 
• Scores outside of accurate range (*) 
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Test History – Student Test Summary by Class (STS) 

Access TE: Reports > Test Results > Test History > Student Test Summary 

 

The Student Test Summary by Class report lists every student that has taken a test in the selected class 
and displays test history for each student.  

Tests are listed in test date order for each student. 

The report displays test date, the specific test given (Form number), scale score, and cumulative hours 
of instruction. 

The report also identifies test scores below the accurate range with an asterisk (*) and high-end 
conservative estimate scores with a diamond symbol ().  

How to use: 
• Identify all tests each student has taken in a class. 
• Identify test scores that are invalid (asterisk) in a class. 
• Identify students who have taken a specific test (Form Number) in a class. 
• Sort tests by form number to see what students have taken each test. 

1. In General Settings > Special Options, set Display Class Based On > Class Enrollment. 
2. Use the Navigator to select a Class Instance and generate the STS. 
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Reports Manager 

The Reports Manager is a virtual file cabinet that you have access to at any 
time, and from any location with Internet access to retrieve your saved reports. 

 

My Reports 

The My Reports menu will become available after you 
set up shortcuts to your favorite reports using the Report 
Locator Wizard. 

Report Locator Wizard 

The Report Locator Wizard menu becomes available 
after you set up shortcuts to your favorite reports using 
the Report Locator Wizard. 
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Steps to Exit TE 

To ensure data is secure and confidential and that unauthorized personnel are unable to gain access to 
personal data, it is important to disconnect from the server before exiting TE. 

Step Screen Description 
1.  

 
 
 
 
 

• When you are finished working in TE, or at 
any time you have several tabbed pages 
open, 

o Click Pages at top right. 

• From the drop-down menu, 

o Click Close All Pages. 

 

2.  

 
 
 
 
 

• At top left of your screen, 

o Click the TE icon. 

o Click Disconnect. 

3.  

 
 
 

• Click the TE icon again. 

o Click Exit. 

o Or click the Red X Box at top right of 
your screen. 
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CASAS Contact Information 

Mail: 
 

CASAS 
5151 Murphy Canyon Rd., Suite 220 
San Diego, CA 92123-4339 

Website: www.casas.org 

Telephone: (858) 292-2900 or toll free (800) 255-1036 

Fax: (858) 292-2910 

 E-mail: 

General questions:  casas@casas.org 

Training questions:  training@casas.org 

Ordering questions:  orders@casas.org 

Field Testing Opportunities fieldtesting@casas.org 

California Accountability:  capm@casas.org 

California AEBG - Adult Ed Block Grant:  aebg@casas.org 

CASAS Technology Support Team: techsupport@casas.org 
 

Training Support 

Help documentation is available at CASAS Home > Training and Support >  
• eTests Online Help 
• TOPSpro Enterprise Help 

Enroll in a complimentary workshop at: CASAS Training Registration. 
 

Technical Support 

The CASAS Technology Support Team is available to provide technical assistance for successful online 
implementation and uninterrupted test delivery. 

• 7:00 am – 5:00 pm (Pacific Time) 
• Monday – Friday 
• techsupport@casas.org 
• (858) 292-2900 or toll free (800) 255-1036, option 2 

https://www.casas.org/training-and-support
http://www.casas.org/
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mailto:training@casas.org
mailto:orders@casas.org
mailto:fieldtesting@casas.org
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mailto:aebg@casas.org
mailto:techsupport@casas.org
https://www.casas.org/
https://www.casas.org/training-and-support
https://www.casas.org/training-and-support/et-help-documentation
https://www.casas.org/training-and-support/te-help-documentation
http://www2.casas.org/online_registration/
mailto:techsupport@casas.org
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Thank you for your participation! 
 
 
 

 


	Navigating TE
	Install and Open TE Online
	Explore Menus and Submenus

	Finding Information
	Understanding the Relationship of Records in TE
	Customizing Lists of Records
	Using the Navigator
	Editing Student Information

	Adding Records Manually
	Steps to Add Sites
	Steps to Add and Manage Users
	Defining Group Access Rights

	Steps to Add and Link Personnel Records
	Personnel Registration
	Functional Roles

	Steps to Add Student Records
	Steps to Add Test Records

	Tracking Results
	Customizing the Tests Lister

	Steps to Generate Reports
	CASAS eTests Reports
	Next-Assigned Test (NAT)
	Personal Score Report (PSR)

	Skills Profile Reports
	Student Individual Skills Profile (ISP)
	Skills Profile – Class Summary (ISPS)

	Competency Performance Reports
	Competency Performance – Student (SCP)
	Competency Performance – Class (SCPS)

	Content Standards Reports
	Content Standards – Student Performance (SCS)
	Content Standards – Class Performance Summary (SCSS)

	Learning Gains Reports
	Learning Gains – Student (LG)
	Learning Gains – Class Summary (LGS)

	Test Response Reports
	Test Response – Class Profile (CPL)

	Test History – Student Test Summary by Class (STS)
	Reports Manager
	My Reports
	Report Locator Wizard

	Steps to Exit TE
	CASAS Contact Information

